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MobileAware Interaction Server 
Installation Guide

About This Manual
This document describes the process for installing and configuring the MobileAware Interaction 
Server, BEA WebLogic Edition.

Please read this document before commencing installation to ensure you comply with the 
installation pre-requisites and have access to relevant installation configuration information.

The document is split into two parts:

Installing the MobileAware Interaction Server on Microsoft Windows 2000

This section describes the installation and configuration of:

1. The MobileAware Interaction Server, BEA WebLogic Edition, including the Mobility 
Extension for BEA WebLogic Workshop 8.1 on Microsoft Windows 2000. 

2. A BEA Sample Workshop Mobility Project used to illustrate how to use the features 
provided by the Mobility Extension.

3. A BEA Sample Mobility Portal Project for BEA WebLogic Platform 8.1, demonstrating the 
features of MobileAware’s Mobilized BEA WebLogic Portal Framework solution.

The section also describes:

Configuration of device emulators in BEA WebLogic Workshop

Creating the necessary Domains and Applications required for importing the sample 
projects using the BEA Configuration Wizard
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Importing the Sample Projects into BEA WebLogic Workshop

Installing the MobileAware Device Database with BEA WebLogic Workshop

Installing the MobileAware Interaction Server on Sun Solaris, RedHat Linux, or HP-UX

This section describes the installation and configuration of:

1. The MobileAware Interaction Server, BEA WebLogic Edition on Sun Solaris, RedHat Linux 
and HP-UX

2. The MobileAware Device Database

Installing the MobileAware Interaction Server on Microsoft 
Windows 2000

This section explains the installation procedure for installing the MobileAware Interaction 
Server, BEA WebLogic Edition for BEA WebLogic Platform 8.1 on Microsoft Windows 2000.

Introduction
The BEAMAInteractionServer814-win.exe installation program is used to install the 
MobileAware Interaction Server, BEA WebLogic Edition on Microsoft Windows 2000.

It also installs the MobileAware Mobility Extension for BEA WebLogic Workshop 8.1 and 
places copies of the Sample Projects for BEA WebLogic Platform 8.1 on your hard drive so that 
they can later be imported into BEA WebLogic Workshop Applications.

License
You must update your BEA License with the MobileAware Interaction Server, BEA WebLogic 
Edition product component details. The required product component information is available for 
download from the BEA Web Site at the same location as the software installers.

Once you have updated your license, you will be able to develop and test mobile-device ready 
content. If you have a developer or evaluation BEA License, the software installers will install an 
evaluation version of the MobileAware Device Database enabling testing on a number of popular 
device emulators as well as a number of popular mobile and PDA devices.  A production license 
must be present to install and utilise the full MobileAware Device Database. Note: An invalid 
license will result in HTML being delivered.

Please contact a BEA or MobileAware sales representative if you wish to extend your evaluation 
or developer license or upgrade to a production license.
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Installation Pre-requisites

Software Pre-Requisites
The following software must be installed prior to installing the MobileAware Interaction Server, 
BEA WebLogic Edition:

BEA WebLogic Platform 8.1SP2, SP3 or SP4, including:

– BEA WebLogic Application Server 

– BEA Workshop

– PointBase database

Internet Browser: 

– Netscape 4.75 or higher, or

– Internet Explorer 5 or higher

Windows 2000

Java JDK / JRE 1.4.1 or 1.4.2 should be on the search path, with JAVA_HOME set 
correctly

Administration Rights
This installation program requires administration rights on the machine in order to complete the 
installation. 

License
Ensure that you have updated your BEA License with the MobileAware Interaction Server, BEA 
WebLogic Edition product component details. The required license component information can 
be downloaded from the same download page as the software installer.

Installation Procedure for Windows
1. Run the BEAMAInteractionServer814-win.exe installation program.

2. When the “Introduction” screen is shown. Click Next to continue.  



Mobi leAware  In te rac t ion Se rve r  Insta l la t ion Gu ide

4 MobileAware Interaction Server Installation Guide 

Figure 1   MobileAware Interaction Server Introduction Screen 

3. On the “License Agreement” screen, read the license agreement and select the I accept the 
terms of the License Agreement radio button if you are satisfied with the terms. Click Next 
to continue with the install. 

Note: The Next button is unavailable if the terms are not accepted. 
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Figure 2   License Agreement Screen

4. On the “Locate WebLogic Installation” screen, enter the location of your WebLogic 8.1 
Installation or click Choose to browse to the location.. This is where the MobileAware 
Interaction Server, BEA WebLogic Edition and the MobileAware Mobility Extension for 
BEA WebLogic Workshop 8.1 will be installed.

5. Once you have indicated the install folder, click Next to continue.
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Figure 3   Location WebLogic Installation Screen 

6. On the “Pre-Installation Summary Screen”, review the installation configuration 
information. If the information is correct, click Install. Otherwise, click Previous to go back 
through the screens and modify the provided information.
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Figure 4   Pre-Installation Summary Screen 

7. You will now see a series of “Installing MobileAware Interaction Server” screens followed 
by an “Updating Workshop” screen while the installation and configuration of the 
MobileAware Interaction Server completes.

Note: It really does take several minutes to update the Workshop help files!
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Figure 5   Installing MobileAware Interaction Server Screen 1

Figure 6   Installing MobileAware Interaction Server Screen 2 
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Figure 7   Please Wait, Updating Workshop Screen 

8. The “Online Help” screen will be displayed following a successful install. Check “Yes” to 
view the online help in Internet Explorer. Click Next

Figure 8   Online Help Screen
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9. The “Install Complete” screen will be displayed following a successful install. Click Done 
to exit the installer.

Figure 9   Installation Complete Screen 

Configuring the MobileAware Interaction Server

Introduction
The location of the MobileAware Interaction Server installation was pre-configured during the 
installation to <bea installation directory>\weblogic81\mobileaware. 

For advanced users who may have multiple installations of the MobileAware Interaction Server, 
this section describes how to re-configure the MobileAware Interaction Server location for use 
with the MobileAware Sample Projects for BEA Workshop and BEA Portal.

Configuring the MobileAware Interaction Server Location
To configure the MobileAware Interaction Server location:

1. Select the MobileAware MIS tab from the IDE Properties within your BEA Workshop 
Environment (Choose Tools > IDE Properties) and click OK.
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Figure 10   IDE Properties 

2. he location of the MobileAware Interaction Server installation was pre-configured during 
the installation to <bea installation directory>\weblogic81\mobileaware. To change the 
location to point at a different MobileAware Interaction Server installation, enter the 
location of the MobileAware Interaction Server installation in the MIS Install Location field 
or click Browse to browse to the location.  This will enable access to device diagnostic and 
device management tools from within BEA WebLogic Workshop.
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Figure 11   MobileAware Interaction Server Location

Creating the Workshop Domain and Installing the Sample 
Workshop Projects

Introduction
This section describes creating a BEA Workshop Domain, creating a new application, and then 
importing the provided Sample Workshop Projects into the newly created domain.

Create Mobility Domain
To create the Mobility Domain:

1. Launch the BEA WebLogic Configuration wizard from the Windows Start menu.
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Choose Start  >  Programs  >  <BEA install directory>  >  Configuration Wizard

If you have BEA Workshop open, you can also launch it from the tools menu. 

Choose Tools  >  WebLogic Server  >  Configuration Wizard

2. Select “Create a new WebLogic configuration” and click Next.

Figure 12   Configuration Wizard – Create a new WebLogic Configuration 

3. In the “Select a Configuration Template screen”, select “Basic WebLogic Workshop 
Domain” and click Next.

Figure 13   Configuration Wizard – Basic WebLogic Workshop Domain

4. On the “Choose Express or Custom Configuration” screen, select “Express” and click Next.



Mobi leAware  In te rac t ion Se rve r  Insta l la t ion Gu ide

14 MobileAware Interaction Server Installation Guide 

Figure 14   Configuration Wizard – Express Configuration 

5. On the “Configure Administrative Username and Password” screen enter “weblogic” for 
username and “weblogic” for password and click Next.

Figure 15   Configuration Wizard – User Name and Password 

6. On the “Configure Server Start Mode and Java SDK” screen, select Development Modeh 
within the WebLogic Configuration Startup Mode box.

7. Select the Sun JDK within the Java SDK Selection area and click Next.
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Figure 16   Configuration Wizard – Start Mode

8. On the  Create WebLogic Configuration  screen, enter  Mobility  in the Configuration Name 
field and click Create.

Figure 17   Configuration Wizard – Mobility
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9. The configuration wizard will now create the domain. When it completes, click Done on the 
Creating Configuration screen.

Figure 18   Configuration Wizard – Creating Configuration 

Note: When you create a domain using the BEA WebLogic Configuration Manager, a default 
PointBase database is installed. The MobileAware Device Database will be installed into 
this database as described in  Installing the MobileAware Device Database. 

Create Mobility Application
To create the Mobility application:

1. To create a new application in Workshop:

Choose  file   >  new  >  application 
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Figure 19   Create New Application 

2. From the  New Application  window:

a. Select Default Application

b. Click Browse next to the Directory field and browse the Domains directory, selecting your 
newly created  Mobility  domain.

c. Enter  MobilityApp  in the Name field – this is the application where you will import the 
sample mobility application.

d. Click Browse next to the Server field and select the config.xml file inside the newly 
created  Mobility  domain.   

3. Once you have filled in the fields as above, click Create and the application will be created.
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Figure 20   New Application Dialog 

Now that you have created a new Domain and a new Application, you can import the sample 
Workshop mobility project. 

Importing the Sample Workshop Mobility Project
The sample Workshop Mobility project is located in the 
<bea>\weblogic81\mobileaware\samples\BEAWorkshop directory. 

Two versions of the project called restaurantWeb and restaurantWeb_After were installed during 
the Mobility Extension installation. The restaurantWeb project has not yet been mobilized, while 
the restaurantWeb_After project has already been fully mobilized. 

You can install the restaurantWeb project as described below and then follow the steps described 
in the BEA Sample Workshop Mobility Project Guide to mobilize it.

1. Right click the newly created  MobilityApp  application in the Application tree window.

2. Select Import Project.
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Figure 21   Import Project 

3. On the  Import Project – New Project  screen, click  Browse  next to the Directory: field and 
browse to the  <bea>\weblogic81\mobileaware\samples\BEAWorkshop\  directory.

Figure 22   Import New Project 

4. Select  restaurantWeb and click Open.
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Figure 23   Locate restaurantWeb

5. Back on the  Import Project - New Project  screen, the Directory will now be filled in, with 
a default Name for the application set to  restaurantWeb . Select  Web Project  from the 
right hand pane.

6. Make sure that  Copy into Application Directory  is checked.

7. Click Import.

Figure 24   Import restaurantWeb project 
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You can also choose to import the restaurantWeb_After project to see the final version. The BEA 
Sample Workshop Mobility Project Guide document explains the steps to mobilize the 
restaurantWeb project to reach the same results as in the restaurantWeb_After project.

Creating the Portal Domain and Creating the Sample Mobility 
Portal Project

Introduction
This section describes creating a BEA Portal Domain, creating a new application, and then 
creating a Sample Mobility Portal Project in the newly created domain using the supplied 
template.

Create MobilityPortal Domain
To create the MobilityPortal Domain:

1. Launch the BEA WebLogic Configuration wizard from the Windows Start menu.

Choose   Start   >  Programs   >  <BEA install directory>   >  Configuration Wizard

If you have BEA Workshop open, you can also launch it from the tools menu.

Choose Tools   >  WebLogic Server   >  Configuration Wizard

2. Select  Create a new WebLogic configuration  and click Next.

Figure 25   Configuration Wizard – Create a new WebLogic Configuration 

3. On the  Select a Configuration Template screen , select  Basic WebLogic Portal Domain  
and click Next.
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Figure 26   Configuration Wizard – Basic WebLogic Portal Domain 

4. On the  Choose Express or Custom Configuration  screen, select  Express  and click Next.
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Figure 27   Configuration Wizard – Express Configuration 

5. On the  Configure Administrative Username and Password  screen enter  weblogic  for 
username and  weblogic  for password and click Next.

Figure 28   Configuration Wizard – User Name and Password

6. In the  Configure Server Start Mode and Java SDK  screen, select Development Mode 
within the WebLogic Configuration Startup Mode box.

7. Select the Sun JDK within the Java SDK Selection area and click Next.
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Figure 29   Configuration Wizard – Start Mode 

8. On the  Create WebLogic Configuration  screen, set the Configuration Name to  
MobilityPortal  and click Create.

Figure 30   Configuration Wizard – Mobility Portal 
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9. The configuration wizard will now create the domain. When it completes, click Done on the 
Creating Configuration screen.

Figure 31   Configuration Wizard – Creating MobilityPortal Configuration 

Note: When you create a domain using the BEA WebLogic Configuration Manager, a default 
PointBase database is installed. The MobileAware Device Database will be installed into 
this database as described in  Installing the MobileAware Device Database. 

Create the MobilityPortalApp Application
To create the MobilityPortalApp application:

1. To create a new application in Workshop, choose

file   >  new   >  application 
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Figure 32   Create New Application 

2. From the New Application window:

a. Select Portal Application

Note: Do not select Default Application as done earlier.

b. Click Browse next to the Directory field and browse the Domains directory, selecting your 
newly created  MobilityPortal  domain.

c. Enter  MobilityPortalApp  in the Name field – this is the application where you will import 
the sample mobility portal application.

d. Click Browse next to the Server field and select the config.xml file inside the newly 
created  MobilityPortal  domain.

3. Once you have filled in the fields as above, click Create and the application will be created.
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Figure 33   Create Portal Application Dialog

Now that you have created a new Domain and a new Portal Application, you can import the 
sample Workshop mobility portal project.

Creating the Sample Workshop Mobility Portal Project
When MobileAware Interaction Server, BEA WebLogic Edition was installed, a Sample Mobile 
Portal Project template was created. Create the sample Workshop mobility portal project using 
this template as described below and then refer to the BEA Sample Mobility Portal Guide for an 
explanation of the features of the sample portal. 

1. Right click the newly created  MobilePortalApp  application in the Application tree window.

2. Select New > Project.
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Figure 34   New Portal Project 

3. On the “New Project” screen, select “MobileAware” and “Sample Mobile Portal.”

Figure 35   Import New Project 

4. Enter “maportal” in the Project Name field.

5. Click Create. 
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Figure 36   Create New Project

6. Make sure that  Copy into Application Directory  is checked.

7. Click Import.

The BEA Sample Mobility Portal Guide document explains the features of the  maportal  sample 
project.

Installing the MobileAware Device Database
The MobileAware Interaction Server requires a database, the MobileAware Device Database, to 
store device profile information. The Mobility Extension for BEA WebLogic Workshop enables 
installation of the Device Database directly into a local PointBase database from the Tools menu 
in BEA WebLogic Workshop.

Installing the Device Database from BEA Workshop Tools Menu
When you created the Mobility and MobilityPortal domains using the BEA WebLogic 
Configuration Manager, a PointBase database was installed. The MobileAware Device Database 
can be installed in this database as follows:

1. Start the WebLogic server for this domain:
Choose Tools  > WebLogic Server  > Start WebLogic Server
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Figure 37   Start BEA WebLogic Server

2. Once the server has started, install the MobileAware Device Database:
Choose Tools  > Mobility  > Install MobileAware Device Database

Figure 38   Install MobileAware Device Database 

3. A confirmation pop-up box will be presented, read and click OK to continue. 
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4. Once successfully installed a popup window will appear with "The MobileAware Device 
database has been installed ", click OK to continue.

Next, you will need to configure device emulators into your Workshop environment.  This is 
described in the next section.

Configuring the Device Emulators

Introduction
This section describes how to configure the emulators for use within BEA Workshop. You can 
use the device emulators to see how the mobilized content will look on a particular device (for 
example phones, PDAs). Several emulators are available for download free of charge on the 
Internet. This section describes how to configure the emulators for use within BEA Workshop.

1. To configure the tools and emulators for usage within the BEA Workshop environment, select 
IDE properties from the Tools Menu.
Choose Tools   >  IDE Properties

Figure 39   Select IDE Properties 

2. Now configure the emulators:

a. Select the Emulators tab.

b. Select WAP1.x emulator by browsing to the appropriate emulator executable file.

Note: MobileAware recommends using the Openwave Emulator, which can emulate 
WAP 1.x and XHTML-MP devices. However, emulators from Nokia, Ericsson, 
or others can also be utilised. If using an Openwave Emulator, select the 
OSDK62http.exe (for version 6.2) or the OSDK61http.exe (for version 6.1) in 
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the installation directory where you have installed the emulator, for example 
C:\Program Files\Openwave\SDK 6.1\program\http.

c. Select WAP2.0 emulator by browsing to the appropriate emulator executable file.

d. Select PDA emulator by browsing to the appropriate emulator executable file.

– You can find a MobileAware PDA emulator at

<bea>\weblogic81\mobileaware\tools\emulators\mobileaware\PDA.exe. 

– Alternatively, to set up Microsoft Internet Explorer to function as a PDA emulator, 
browse to your iexplore.exe in the PDA emulator text box as can be seen in the 
diagram below and check the box next to  Override device recognition to force PDA 
content . 

Figure 40   Setting up Internet Explorer as a PDA Emulator 
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Next Steps
Now that you have successfully installed the MobileAware Interaction Server, BEA WebLogic 
Edition, you are almost ready to begin mobilizing your own web applications and portal projects. 

Before you do, it is recommended that you go through the BEA Sample Workshop Mobility 
Project Guide and the BEA Sample Mobility Portal Guide. The BEA Sample Workshop Mobility 
Project Guide provides a step-by-step exercise in mobilizing a sample workshop application, 
while the BEA Sample Mobility Portal Guide illustrates the features of a Mobilized BEA Portal 
Framework.

Installing the MobileAware Interaction Server on Sun Solaris, 
RedHat Linux, or HP-UX

This section explains the installation procedure for installing the MobileAware Interaction 
Server, BEA WebLogic Edition for BEA WebLogic Platform 8.1 on Sun Solaris, Redhat Linux, 
and HP-UX 11.

Introduction
The BEAMAInteractionServer814-<platform>.bin installation program is used to install the 
MobileAware Interaction Server, BEA WebLogic Edition on.

For RedHat Linux, use the BEAMAInteractionServer814-linux.bin installer.

For Sun Solaris, use the BEAMAInteractionServer814-solaris.bin installer.

For HP-UX, use the BEAMAInteractionServer814-hpux.bin installer.The installer 
installs the MobileAware Interaction Server, BEA WebLogic Edition into an existing BEA 
WebLogic installation at <bea_home>/weblogic81/mobileaware.

License
You must update your BEA License with the MobileAware Interaction Server, BEA WebLogic 
Edition product component details. The required product component information is available for 
download from the BEA Web Site at the same location as the software installers.

Once you have updated your license, you will be able to develop and test mobile-device ready 
content. If you have a developer or evaluation BEA License, the software installer will install an 
evaluation version of the MobileAware Device Database enabling testing on a number of popular 
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device emulators as well as a number of popular mobile and PDA devices.  A production license 
must be present to install and utilise the full MobileAware Device Database. 

Note: An invalid license will result in HTML being delivered.

Please contact a BEA or MobileAware sales representative if you wish to extend your evaluation 
or developer license or upgrade to a production license.

Installation Pre-requisites

Software Pre-Requisites
The following software must be installed prior to installing the MobileAware Interaction Server, 
BEA WebLogic Edition:

A supported Operating System, from the following list:

– Sun Solaris 8, 9

– RedHat Linux 2.1, 3.0

– HP-UX 11

BEA WebLogic Platform 8.1SP2, SP3, or SP4

A Database, from the following list: 

– Oracle 9i

– PointBase 4.4

– SQL Server 2000

– Postgres 7.3.2+

– Sybase Adaptive Server Enterprise 12.5

– IBM DB2 Universal Database 8.1

Internet Browser: 

– Netscape 4.75 or higher, or

– Internet Explorer 5 or higher

Java JDK / JRE 1.4.1 or 1.4.2 should be on the search path, with JAVA_HOME set 
correctly
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License
Ensure that you have updated your BEA License with the MobileAware Interaction Server, BEA 
WebLogic Edition product component details. The required license component information can 
be downloaded from the same download page as the software installer.

Installation Procedure for Sun Solaris, RedHat Linux, and 
HP-UX
1. Download the appropriate platform installer:

For RedHat Linux, use the BEAMAInteractionServer814-linux.bin installer.

For Sun Solaris, use the BEAMAInteractionServer814-solaris.bin installer.

For HP-UX, use the BEAMAInteractionServer814-hpux.bin installer.

2. Open an xterm, telnet, or console window and run the appropriate platform MobileAware 
Interaction Server installation program as identified above.  

3. The first stage of the installation is the Introduction. Please read the text and ensure that the 
installation environment meets the stated requirements. Press <Enter> to continue.

4. Next is the License Agreement. Read the license agreement text and enter the value  Y  if 
you accept the terms of the license agreement, or the value  N  if you do not. 
Note: this will cancel the installation after prompting you to confirm cancellation.

5. When Locate WebLogic Installation is shown, you must enter an absolute path to the 
location of the BEA WebLogic installation where the MobileAware Interaction Server 
should be installed. If BEA WebLogic is already installed, the installer will display the most 
recent <bea_home> by default. Press <Enter> to accept the default location as shown. 

Alternatively, if you want to install the MobileAware Interaction Server into a different 
BEA WebLogic installation, enter the absolute path to the location of the appropriate BEA 
WebLogic installation and press <Enter>. 
Note: You must have write and execute permissions for the chosen installation folder.

6. Next is the Pre-Installation Summary. Review the displayed installation configuration 
settings to ensure they are correct. If you are satisfied with the configuration settings, press 
<Enter> to continue. Otherwise, type back to return to a previous step and modify the 
configuration settings.

7. The Installation Complete message will be displayed following a successful install. Press 
<Enter> to exit the installer.
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Installing the MobileAware Device Database
Please refer to the section  Installing the Device Database with the Device Installer  for 
instructions on installing the MobileAware Device Database.

Configuration of a MobileAware Interaction Server-Enabled 
Web Application
Please refer to” Deploying an Application” in the MobileAware Interaction Server, BEA 
WebLogic Edition Administration Guide for details on:

Creating the deployment environment for a mobilized web application

Configuring the MobileAware Interaction Server servlet filter

Configuring the web application’s Web Deployment Descriptor (web.xml file) for the 
MobileAware Interaction Server servlet filter

Post-Installation Configuration and Use of the Administration 
Tools
Please refer to “Administration Console” in the MobileAware Interaction Server, BEA WebLogic 
Edition Administration Guide for a description of how to use the Administration Console to 
manage device profiles in the MobileAware Device Database.

Please refer to  “Working With Diagnostics” in the MobileAware Interaction Server, BEA 
WebLogic Edition User Guide for information on configuring and using the Diagnostics tools.

Installing the Device Database

Introduction
The MobileAware Interaction Server requires a database, the MobileAware Device Database, to 
store device profile information. Currently, the MobileAware Device Database supports Oracle, 
MySQL, Postgres, PointBase, and SQL Server 2000, IBM DB2 Universal Database, and Sybase 
Adaptive Server Enterprise databases.

The following installation procedures assume an Oracle, MySQL, Postgres, PointBase, SQL 
Server 2000, IBM DB2, or Sybase database has already been installed and the administrator 
performing the installation is familiar with database creation.
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The MobileAware Device Database can alternatively be configured to operate directly from an 
XML file. For configuration of the MobileAware Device Database to operate directly from an 
XML file, please refer to “Configuration of XML File-based MobileAware Device Database.” 

After completing the MobileAware Device Database installation below, configure the 
mis.properties settings as described in the next chapter.

About the Device Installer Tool
MobileAware has developed a GUI tool called the Device Installer that is used to perform both 
initial installations of the MobileAware Device Database, as well as installations of the 
MobileAware provided quarterly updates to the MobileAware Device Database. 

Note: Note: Individual additions and modifications to an installed MobileAware Device 
Database are made using the Administration Console, which is documented in the 
MobileAware Interaction Server, BEA WebLogic Edition Administration Guide. 

The Device Installer tool itself allows customers to:

Create a new MobileAware Device Database from a MobileAware provided flat 
DeviceRepository.xml file

Backup a customer’s existing MobileAware Device Database to an XML file

Update a customer’s existing MobileAware Device Database with the MobileAware 
provided quarterly updates (the quarterly updates are also provided as a flat 
DeviceRepository.xml file)

When using the Device Installer tool to install the MobileAware provided quarterly updates, the 
tool: 

Backs up the customer’s existing device database to an XML file 

Detects and stores customer modifications to their existing device database 

Installs the new MobileAware provided device database

Presents the customer with a list of modifications and allows the customer to re-apply each 
of them or accept the values provided in the device database update

Locating the Device Installer Tool
The Device Installer tool can be found under the installation directory that was selected during 
the installation:
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For Windows, this will be:
<install_directory>\applications\DeviceInstaller\MISDeviceInstaller.exe

For UNIX, this will be:
<install_directory>/applications/DeviceInstaller/MISDeviceInstaller

The  “Install Complete “ screen at the end of the MobileAware Interaction Server installation 
contained the full path name for the install directory for reference.

Note: The Device Installer is a GUI based application that must be run on a system with a 
windowing environment.

You may therefore run it in a Unix / Linux environment running X Windows, or on a Microsoft 
Windows environment.

The Device Installer connects directly to the database within which the Device Database is to be 
installed, so it is not necessary to run it on the same platform on which the MobileAware 
Interaction Server was installed.

Pre-configuration for Support of IBM Universal DB2 
If using the Device Installer Tool to install the MobileAware Device Database on IBM Universal 
DB 2, please copy the following driver files from <ibm DB2 
install_directory>\SQLLIB\java (for example, C:\Program Files\IBM\SQLLIB\java) 
to <install_directory>\applications\DeviceInstaller:

db2jcc.jar

db2jcc_license_cu.jar

This will enable the Device Installer to install and/or update the MobileAware Device Database 
into a configured IBM Universal DB2 database.

Pre-configuration for Support of SQL Server 2000 
If using the Device Installer Tool to install the MobileAware Device Database on SQL Server 
2000, please download the necessary JDBC drivers from:

http://www.microsoft.com/downloads/details.aspx?FamilyID=86212d54-8488-481d-b46b-af29
bb18e1e5&displaylang=en 

and then copy the following files to <install_directory>\applications\DeviceInstaller:

msbase.jar

mssqlserver.jar
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msutil.gar

This will enable the Device Installer to install and/or update the MobileAware Device Database 
into a configured Microsoft SQL Server 2000 Database.

Device Installer Scenario 1: Installing a New MobileAware 
Device Database
The steps used to install a new MobileAware Device Database are shown below, along with 
sample screenshots:

1. Create a database for the MobileAware Device Database and note the connection details. To 
complete the device database installation, you will need the database type, the database URL, 
and a valid user name and password for accessing the database. 

2. Run MISDeviceInstaller.exe (Windows) or MISDeviceInstaller (Unix/Linux platforms) and 
the  Device Installer Usage  screen will appear. Click Continue.  

Figure 41   Device Installer Usage Screen 

3. The  MobileAware Device Database Options  screen will appear. Click Load File to install 
the MobileAware Device Database from the DeviceRepository.xml file included with the 
MobileAware Interaction Server installer.
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Figure 42   MobileAware Device Database Options

4. When the  Select MIS Device XML file  screen appears, choose a DeviceRepository.xml 
file to install and click Open. The DeviceRepository.xml file included with the 
MobileAware Interaction Server installer will be shown as the default for a new installation. 

Figure 43   Select MobileAware Device XML File Screen 

5. The DeviceRepository.xml  screen shows the DeviceRepository.xml to be installed. 
The file has been converted into a hierarchical structure and provided as a preview of the 
MobileAware Device Database to be installed. Inherited values for each device can also be 
displayed by checking the  show inherited values  box. Click Begin Installation to proceed.
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Figure 44   DeviceRepository.xml Screen

6. In the Database Connection Details screen, select the type of database from the  Database 
Type  drop down menu and enter the database connection details in the format shown. The 
Database URL, User Name, and Password should be available from your Database 
Administrator (DBA). The format for these URL’s is displayed in the dialog and is also 
described below:

For Oracle, set to:
jdbc:oracle:thin:@<oracle_host>:<oracle_port>:<oracle_database_name>

For MySQL, set to:
jdbc:mysql://<mysql-server-ip:port>/ 
<db-name>?user=<connect-user>&password=<connect-password>

For Postgres, set to:
jdbc:postgresql://<postgres_machine>:<postgres_port>/<postgres_database_name>

For PointBase, set to:
jdbc:pointbase:server://<ip_address>:<port>/<SID>

ForSybase ASE, set to:
jdbc:sybase:Tds:<ip_address>:<port>/SID
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For IBM DB2, set to:
jdbc:db2://<ip_address>:<port>/SID

For Microsoft SQL Server 2000:
jdbc:bea:sqlserver://<sqlserver_host>:<sqlserver_port>;databaseName=<sqlserver_database
_name>

When using WebLogic database connection pool, set to:
jdbc:weblogic:pool:<poolname>

Example: deviceDB.url: jdbc:oracle:thin:@oracle_host:1521:mySID

7. Click Connect. Once a successful connection is made the details are stored and will be 
remembered the next time the tool is run. 

Figure 45   Example of PointBase Connection Details screen

8. A progress bar shows the progress of the data installation.

Figure 46   Creating Device Table Progress Bar 

9. Click OK on the  Database Installation Complete  screen and then click Exit on the  Device 
Installer  screen to close the tool.
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Figure 47   Database Installation Complete 

Device Installer Scenario 2: Using MobileAware’s Online 
Update Service to Update the MobileAware Device Database
The steps used to connect to MobileAware’s Online Update Service to update an existing 
MobileAware Device Database are described below.

1. Run MISDeviceInstaller.exe (Windows) or MISDeviceInstaller (Unix/Linux 
platforms) and the  Device Installer Usage  screen will appear. Click Continue.  

Figure 48   Device Installer Usage Screen

2. The  MobileAware Device Database Options screen will appear. Click Connect to connect 
to MobileAware’s online update service for the latest available DeviceRepository.xml 
file.
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Figure 49   MobileAware Device Database Options

3. On the  Database Connection Details  screen, select the type of database from the  Database 
Type  drop down menu and enter the database connection details in the format shown. The 
Database URL, User Name, and Password should be available from your Database 
Administrator (DBA). The format for these URL’s is displayed in the dialog and is also 
described below:

For Oracle, set to:
jdbc:oracle:thin:@<oracle_host>:<oracle_port>:<oracle_database_name>

For MySQL, set to:
jdbc:mysql://<mysql-server-ip:port>/ 
<db-name>?user=<connect-user>&password=<connect-password>

For Postgres, set to:
jdbc:postgresql://<postgres_machine>:<postgres_port>/<postgres_database_name>

For PointBase, set to:
jdbc:pointbase:server://<ip_address>:<port>/<SID>

For Sybase ASE, set to:
jdbc:sybase:Tds:<ip_address>:<port>/SID

For IBM DB2, set to:
jdbc:db2://<ip_address>:<port>/SID
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For Microsoft SQL Server 2000:
jdbc:bea:sqlserver://<sqlserver_host>:<sqlserver_port>;databaseName=<sqlserver_database
_name>

When using WebLogic database connection pool, set to:
jdbc:weblogic:pool:<poolname>

Example: deviceDB.url: jdbc:oracle:thin:@oracle_host:1521:mySID

4. Click Connect. Once a successful connection is made the details are stored and will be 
remembered the next time the tool is run. 

5. If you successfully connect and are authorized to receive the latest 
DeviceRepository.xml file, it will be downloaded and the next screen you will see is the 
Downloaded File screen shows the DeviceRepository.xml to be installed. The file has 
been converted into a hierarchical structure and provided as a preview of the MobileAware 
Device Database to be installed. Inherited values for each device can also be displayed by 
checking the  show inherited values  box. Click Begin Installation to proceed.

Figure 50   Downloaded File Screen 

6. Re-enter Database Connection Details (may not be required):
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On the  Database Connection Details  screen, select the type of database from the  
Database Type  drop down menu and enter the database connection details in the format 
shown. The Database URL, User Name, and Password should be available from your 
Database Administrator (DBA). The format for these URL’s is displayed in the dialog and 
is also described below:

For Oracle, set to:
jdbc:oracle:thin:@<oracle_host>:<oracle_port>:<oracle_database_name>

For MySQL, set to:
jdbc:mysql://<mysql-server-ip:port>/ 
<db-name>?user=<connect-user>&password=<connect-password>

For Postgres, set to:
jdbc:postgresql://<postgres_machine>:<postgres_port>/<postgres_database_name>

For PointBase, set to:
jdbc:pointbase:server://<ip_address>:<port>/<SID>

For Sybase ASE, set to:
jdbc:sybase:Tds:<ip_address>:<port>/SID

For IBM DB2, set to:
jdbc:db2://<ip_address>:<port>/SID

For Microsoft SQL Server 2000:
jdbc:bea:sqlserver://<sqlserver_host>:<sqlserver_port>;databaseName=<sqlserver_database
_name>

When using WebLogic database connection pool, set to:
jdbc:weblogic:pool:<poolname>

Example: deviceDB.url: jdbc:oracle:thin:@oracle_host:1521:mySID

7. Click Connect. Once a successful connection is made the details are stored and will be 
remembered the next time the tool is run. 

8. If an existing MobileAware Device Database is detected, the  Backup Existing Database to 
XML file  screen is shown and you are required to backup the existing device database to an 
XML file before proceeding. The created backup XML file will have the same structure as 
the DeviceRepository.xml file. This backup XML file will be used for detecting 
modifications later in the upgrade process. Enter a name for the XML file and click Backup.
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Figure 51   Backup Existing Device Database Screen 

9. A progress bar monitors the progress of the backup process. This may take up to 2 minutes 
depending on the connection.

Figure 52   Backup Progress Bar

10. Detect Custom Devices/Attributes:

The backupDeviceRepository.xml and DeviceRepository.xml files are compared to allow a 
list of modifications to be presented to the user. 

If no modifications are identified, the existing database will be replaced with the selected 
Device XML file. When the  Device Installation Compete  window appears, click OK and 
then click Exit to close the DeviceInstaller tool.

11. If odifications are detected, you will be asked to review the modifications before proceeding 
with the installation.

12. Once the detection process completes, a dialog box similar to the one shown below will 
appear showing the delta between the DeviceRepository.xml file to be installed and the 
existing MobileAware Device Database. You can now choose to re-apply any modifications 
that have been detected in the existing MobileAware Device Database by selecting the 
appropriate  Retain Custom Entry  checkboxes.



Mobi leAware  In te rac t ion Se rve r  Insta l la t ion Gu ide

48 MobileAware Interaction Server Installation Guide 

Figure 53   Comparison of Existing Download Data with New Data 

13. Create the database

After selecting any data that you wish to retain, click Create Database. You will see a  
Warning  dialog box indicating that the MobileAware Device Database data will be 
replaced with the selected data set. Click Yes button to proceed with the installation.

Figure 54   Overwrite Data Screen 

14. A progress bar shows the progress of the data installation.
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Figure 55   Creating Device Table Progress Bar 

15. Click OK on the  Database Installation Complete  screen and then click Exit on the  Device 
Installer  screen to close the tool.

Figure 56   Database Installation Complete

Device Installer Scenario 3: Updating an Existing MobileAware 
Device Database from an XML File
The steps used to update an existing MobileAware Device Database from an XML file are shown 
below, along with sample screenshots:

1. Run MISDeviceInstaller.exe (Windows) or MISDeviceInstaller (Unix/Linux platforms) and 
the  Device Installer Usage  screen will appear. Click Continue.  

Figure 57   Device Installer Usage Screen

2. The  MobileAware Device Database Options  screen will appear. Click Load File to install 
the MobileAware Device Database from a local DeviceRepository.xml.
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Figure 58   MobileAware Device Database Options 

3. Then the  Select MIS Device XML file  screen appears, choose a DeviceRepository.xml file 
to install and click Open. The DeviceRepository.xml file included with the MobileAware 
Interaction Server installer will be shown as the default for a new installation. 

Figure 59   Select MobileAware Device XML File Screen 

4. The  DeviceRepository.xml  screen shows the DeviceRepository.xml to be installed. The 
file has been converted into a hierarchical structure and provided as a preview of the 
MobileAware Device Database to be installed. Inherited values for each device can also be 
displayed by checking the  show inherited values  box. Click Begin Installation to proceed.
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Figure 60   DeviceRepository.xml Screen

5. On the  Database Connection Details  screen, select the type of database from the  Database 
Type  drop down menu and enter the database connection details in the format shown. The 
Database URL, User Name, and Password should be available from your Database 
Administrator (DBA). The format for these URL’s is displayed in the dialog and is also 
described below:

For Oracle, set to:
jdbc:oracle:thin:@<oracle_host>:<oracle_port>:<oracle_database_name>

For MySQL, set to:
jdbc:mysql://<mysql-server-ip:port>/ 
<db-name>?user=<connect-user>&password=<connect-password>

For Postgres, set to:
jdbc:postgresql://<postgres_machine>:<postgres_port>/<postgres_database_name>

For PointBase, set to:
jdbc:pointbase:server://<ip_address>:<port>/<SID>

For Sybase ASE, set to:
jdbc:sybase:Tds:<ip_address>:<port>/SID
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For IBM DB2, set to:
jdbc:db2://<ip_address>:<port>/SID

For Microsoft SQL Server 2000:
jdbc:bea:sqlserver://<sqlserver_host>:<sqlserver_port>;databaseName=<sqlserver_database
_name>

When using WebLogic database connection pool, set to:
jdbc:weblogic:pool:<poolname>

Example: deviceDB.url: jdbc:oracle:thin:@oracle_host:1521:mySID

6. Click Connect. Once a successful connection is made the details are stored and will be 
remembered the next time the tool is run. 

Figure 61   Example of PointBase Connection Details screen 

7. If an existing MobileAware Device Database is detected, the  Backup Existing Database to 
XML file  screen is shown and you are required to backup the existing device database to an 
XML file before proceeding. The created backup XML file will have the same structure as 
the DeviceRepository.xml file. This backup XML file will be used for detecting 
modifications later in the upgrade process. Enter a name for the XML file and click Backup.
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Figure 62   Backup Existing Device Database Screen 

8. A progress bar monitors the progress of the backup process. This may take up to 2 minutes 
depending on the connection.

Figure 63   Backup Progress Bar 

9. Detect Custom Devices/Attributes:

The backupDeviceRepository.xml and DeviceRepository.xml files are compared to allow a 
list of modifications to be presented to the user. 

If no modifications are identified, the existing database will be replaced with the selected 
Device XML file. When the  Device Installation Compete  window appears, click OK and 
then click Exit to close the DeviceInstaller tool.

10. If modifications are detected, you will be asked to review the modifications before 
proceeding with the installation.

11. Once the detection process completes, a dialog box similar to the one shown below will 
appear showing the delta between the DeviceRepository.xml file to be installed and the 
existing MobileAware Device Database. You can now choose to re-apply any modifications 
that have been detected in the existing MobileAware Device Database by selecting the 
appropriate  Retain Custom Entry  checkboxes.
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Figure 64   Comparison of Existing Data with New Data 

12. Create the database

After selecting any data that you wish to retain, click Create Database. You will see a  
Warning  dialog box indicating that the MobileAware Device Database data will be 
replaced with the selected data set. Click Yes button to proceed with the installation.

Figure 65   Overwrite Data Screen 

13. A progress bar shows the progress of the data installation.
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Figure 66   Creating Device Table Progress Bar 

14. Click OK on the  Database Installation Complete  screen and then click Exit on the  Device 
Installer  screen to close the tool.

Figure 67   Database Installation Complete 

Device Installer Scenario 4: Backup an Existing MobileAware 
Device Database to an XML File
The steps used to backup an existing MobileAware Device Database are shown below, along with 
sample screenshots:

1. Run MISDeviceInstaller.exe (Windows) or MISDeviceInstaller (Unix/Linux platforms) and 
the  Device Installer Usage  screen will appear. Click Continue.  

Figure 68   Device Installer Usage Screen 

2. The  MobileAware Device Database Options  screen will appear. Click Backup to backup 
the installed MobileAware Device Database to an XML file.
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Figure 69   MobileAware Device Database Options 

3. On the  Backup Existing Database to XML file  screen, enter a name for the XML file and 
click Backup to backup the existing device database to an XML file.

Figure 70    Backup Existing Device Database Screen 

4. A progress bar monitors the progress of the backup process. This may take up to 2 minutes 
depending on the connection.
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Figure 71   Backup Progress Bar 

5. When the backup completes, exit the tool by select File > Exit.

Configuring mis.properties Settings
The mis.properties file must be updated to reflect the Device Database connection details. This 
enables the MIS to connect to the Device Database to retrieve device profiles for use during 
content transformation.

Note: By default, MIS is configured to communicate to the standard BEA WebLogic Database 
Connection Pool. If you are using the standard BEA WebLogic Database Connection 
Pool, you can skip this section. You are only required to configure the mis.properties 
settings manually if you want to use an alternative database or you have a custom domain 
that is not using the default BEA WebLogic Database Connection Pool.  

The mis.properties File
The configuration file used by the MobileAware Interaction Server that contains the device 
database connection settings is the mis.properties file.

This file can be found in the WEB-INF/classes folder of the web application (e.g. for the sample 
Mobility Portal application it is located at: 
<bea>\weblogic81\mobileaware\samples\BEAWorkshop\maportal\WEB-INF\classes\) 

It is a plain text file that can be edited in any text editor.

This section describes configuration settings for the mis.properties file.

Configuring the MobileAware Device Database Connection 
The following device database properties must be configured in order for MobileAware 
Interaction Server to successfully communicate with the MobileAware Device Database when 
using an external database:
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Property Description

deviceDB.driver Location of the JDBC driver to be used by MobileAware interaction 
Server to gain access to the database. 

This property also has the effect of informing MobileAware Interaction 
Server which database it is connected to.

For Oracle, set to: oracle.jdbc.driver.OracleDriver 

For MySQL, set to: org.gjt.mm.mysql.Driver 

For Postgres, set to: org.postresql.Driver 

For PointBase, set to: com.pointbase.jdbc.jdbcUniversalDriver 

For SQL Server (with MIS deployed on BEA WebLogic only), set to: 
weblogic.jdbc.sqlserver.SQLServerDriver 

For Sybase ASE set to: com.sybase.jdbc2.jdbc.SybDriver

For IBM DB2 Universal Database set to: com.ibm.db2.jcc.DB2Driver

To configure MIS to use the BEA WebLogic database connection pool: 
weblogic.jdbc.pool.Driver

Example: deviceDB.driver:oracle.jdbc.driver.OracleDriver
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deviceDB.url The URL to use to access the Device Database. 

For Oracle, set to: 
jdbc:oracle:thin:@<oracle_host>:<oracle_port>:<oracle_database_na
me>

For MySQL, set to:
jdbc:mysql://<mysql-server-ip:port>/ 
<db-name>?user=<connect-user>&password=<connect-password>

For Postgres, set to:
jdbc:postgresql://<postgres_machine>:<postgres_port>/<postgres_data
base_name>

For PointBase, set to:
jdbc:pointbase:server://<pointbase_machine>:<pointbase_port>/cajun

For SQLServer (with MIS deployed on BEA WebLogic only), set to:
jdbc:bea:sqlserver://<sqlserver_host>:<sqlserver_port>;databaseName
=<sqlserver_database_name>

For Sybase ASE set to: jdbc:sybase:Tds:<ip_address>:<port>/SID 

For IBM DB2 Universal Database set to: 
jdbc:db2://<ip_address>:<port>/SID

When using WebLogic database connection pool, set to:
jdbc:weblogic:pool:<poolname>

Example: deviceDB.url: jdbc:oracle:thin:@oracle_host:1521:mySID

deviceDB.user Username used by MobileAware Interaction Server to access the 
database server when user and password authentication is required.

Note: For MySQL, this property is left blank.

Example: deviceDB.user: user

deviceDB.password Password of user used by MobileAware Interaction Server to access the 
database server when user and password authentication is required.

Note: For MySQL, this property is left blank.

Example: deviceDB.password: password

deviceDB.maxDBConnect
ions

A numeric value indicating the number of concurrent database 
connections in the database pool. This is used to control the number of 
concurrent database connections and licenses required by the 
MobileAware Interaction Server. Defaults to 10. See “About 
Connection Pools” below for more information.

Example: deviceDB.maxDBConnections: 10
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About Connection Pools
A dynamic web site often generates HTML pages from information stored in a database. Each 
request for a page results in a database access. Connecting to a database is time consuming since 
the database must allocate communication and memory resources as well as authenticates the 
user and set up the corresponding security context. Setting up the individual connections can 
become a bottleneck. 

Establishing the connection once and using the same connection for subsequent requests can 
therefore dramatically improve the performance of a database driven web application. 
Connection pooling is a technique used to avoid the overhead of making a new database 
connection every time an application or server object requires access to a database. Rather than 
making and breaking connections as required, a "pool" of database connections is maintained by 
the system on the server. When MobileAware Interaction Server needs a database connection, it 
simply requests an available one from the pool - if none is available, a new one is created & added 
to the pool. 

The connection pool not only grows to specified limits, but also contracts as required, closing 
connections that have not been used for a specified time. This avoids taking up system resources 
by simply holding connections that are not currently required. This also handles databases which 
"time-out" their connections, and prevents handing a "stale" connection to an application object.

Configuration of XML File-based MobileAware Device Database
To configure MIS to use an XML File-based MobileAware Device Database instead of 
connecting to an external database (e.g. Oracle, MySQL) where the MobileAware Device 
Database has been installed, the database settings must be defined properly in the mis.properties 
file associated with the web application.

deviceDB.waitTime A numeric value indicating (in milliseconds) the time to wait for a 
connection from the database pool. Defaults to 5000.

Example: deviceDB.waitTime: 5000

deviceDB.increment A numeric value indicating the number of connections to add to the pool 
if there are no connections currently available. If the maximum number 
of connections in the pool has been reached then no new connections 
will be added to the pool. Defaults to 1

Example: deviceDB.increment: 1
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1. Locate the mis.properties file for your web application (e.g. for the sample Mobility Portal 
application, it is located at: 
<bea>\weblogic81\mobileaware\samples\BEAWorkshop\maportal\WEB-INF\classes\) and 
open it in a text editor.

2. Look for the Device Repository Type setting in the mis.properties file, similar to below:
#######################################################

#

# Device Repository Type

# -----------------------------------------

# This setting indicates whether the MobileAware Device Database is

# deployed as an XML file or installed into a JDBC database. 

# Possible values are: xml and db

#

# If not specified, db is assumed.

#deviceRepositoryType: xml

3. Uncomment the last line so that it now reads:
deviceRepositoryType: xml

4. Look for the XML Device Repository File Location setting in the mis.properties file, 
similar to below:

#######################################################

#

# XML Device Repository File Location

# -----------------------------------------

# This setting indicates the location of the Device Repository XML file

# This setting must be set to the location of the xml file or the 

# classpath will be checked (see deviceXML.resourceName)

#

# Example:
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#C\:\\bea81sp3\\weblogic81\\mobileaware\\database\\DeviceRepository.xml

#

#deviceXML.location: 

C\:\\bea81sp3\\weblogic81\\mobileaware\\database\\DeviceRepository.xml

5. Uncomment the ‘deviceXML.location:’ line and change the indicated location to the actual 
location of the DeviceRepository.xml file. The DeviceRepository.xml file included with 
MobileAware Interaction Server is located at: 
<bea>\weblogic81\mobileaware\database\DeviceRepository.xml. For example,

deviceXML.location: 

C\:\\bea81sp3\\weblogic81\\mobileaware\\database\\DeviceRepository.xml

6. Look for the XML Device Repository Resource Name setting in the mis.properties file, 
similar to below

# XML Device Repository Resource Name

# -----------------------------------------

# This setting indicates the name of the Device Repository XML file that 

# should be used in the classpath.

#

# The default is "/DeviceRepository.xml"

#

# Example: deviceXML.resourceName: /DeviceRepository.xml

deviceXML.resourceName: /DeviceRepository.xml

7. If the XML file to be used is not named DeviceRepository.xml, uncomment the 
‘deviceXML.resourceName:’ line and change the indicated resource name to reflect the 
actual name of the XML file to be used. By default, DeviceRepository.xml is assumed.

8. Save the mis.properties file.

9. In production environment, you must now use the BEA WebLogic Administration Console 
to redeploy your web application. In a development environment, the web application can 
simply be redeployed directly from within BEA WebLogic Workshop. 
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Next Steps
Now that you have successfully installed the MobileAware Interaction Server, BEA WebLogic 
Edition, you are almost ready to begin mobilizing your own web applications and portal projects. 

Before you do, it is recommended that you go through the BEA Sample Workshop Mobility 
Project Guide and the BEA Sample Mobility Portal Guide. The BEA Sample Workshop Mobility 
Project Guide provides a step-by-step exercise in mobilizing a sample workshop application, 
while the BEA Sample Mobility Portal Guide illustrates the features of a Mobilized BEA Portal 
Framework.
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